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Методика подключения и настройка принтера 
этикеток Datecs LP-50 для работы с электронными 
весами производства компании МИДЛ  

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

ООО МИДЛ СЕРВИС                                     (495) 988-52-88 
 

Методика подключения и настройка принтера этикеток Datecs LP-50 для работы с 
электронными весами производства компании МИДЛ, поддерживающими протоколы обмена 
Middle и Middel2.. 

 
1. Распаковать принтер и убедиться в наличии 

• Принтера этикеток 
• Блока питания принтера 
• Кабеля подключения принтера к весам и персональному компьютеру 
• Диска с программным обеспечением принтера 
• Руководства пользователя 
• Методики подключения принтера к весам 

 
 
2. Конфигурирование принтера 
 
Если принтер предназначен для работы с весами производства компании «Мидл», то перед 
этим  нужно обновить программное обеспечение принтера. 
 

Принтер конфигурируется посредством DIP-переключателей, расположенных на дне 
отсека рулона чековой ленты (ложемента). Для подключения принтера к весам 
производства компании Мидл, необходимо выставить  DIP-переключатели в следующие 
положения. 1-ON, 2-ON, 3-OFF, 4-OFF, 5-ON, 6-ON, 7-OFF, 8-OFF. 
 

Важно !!! 
 
При создании этикетки и программировании принтера, когда принтер подключен к 

персональному компьютеру, DIP-переключатель sw7 должен находиться в положении OFF.  
 

3. Подключение принтера 
3.1   Используя кабель подключения, подключите  принтер к последовательному порту 
персонального компьютера.  Подключите  кабель  блока питания принтера к круглому 
разъему на задней панели принтера. Подключите кабель блока питания принтера к сети 220 
вольт. Включите принтер с помощью выключателя, который расположен на правой его 
стенке. При этом на передней панели принтера должен загореться светодиод «Power».   

  Заправьте бумажный рулон с этикетками в принтер.  Для этого 
 

 Расположите  рулон с этикетками «языком» вниз и на себя 
 Рычаг прижима ленты переместите в верхнее положение, потянув его вверх 
 Конец ленты заправите в щель лентопротяжного тракта как можно глубже и 

переместите рычаг прижима ленты в нижнее положение 
 Нажимая на передней панели принтера кнопку «LF» протяните ленту до ее 

выхода из печатающего тракта 
 Отогните влево кронштейн фиксации рулона и опустите рулон в ложемент 
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3.2 Двойным щелчком левой кнопкой мыши на имени файла запустите программу 
«DATECS Label Editor». При удачном запуске программы на экране  компьютера должно 
появиться окно программы.   

 
 

  
 
 
 
 
 
 
 
 
 
 
 
Левой кнопкой мыши выберите “Tools”→”Setting”. Должно появиться следующее окно. 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Выберите нужный последовательный порт персонального компьютера из списка доступных,  
установите скорость обмена 9600 бод и мышкой выберите пункт меню “Diagnostic 
Information”. В случае успешного подключения принтер отпечатает диагностическую 
этикетку. 
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4. Загрузка в принтер образа этикетки. 
Принтер работает с весовыми индикаторами и настольными весами производства компании 
«Мидл» поддерживающими протоколы обмена Мидл (торговые весы и индикаторы с 3-мя 
дисплеями «Вес», «Цена» и «Стоимость») и Мидл-2 (весы и индикаторы простого 
взвешивания с одним дисплеем «Вес»).  Принтер автоматически определит, к каким весам он 
подключен, торговым или простого взвешивания. 
 
Важно !!!! 
 
После загрузки в программу «DATECS Label Editor» образа этикетки, ее нужно сохранить в 
памяти принтера под именем 
 

• Middle – если принтер подключается к торговым весам или торговому индикатору 
• Middle2 – если принтер подключается к весам или весовому индикатору простого 

взвешивания 
 
 
4.1 Для загрузки в принтер образа заранее созданной этикетки выполните следующие 
действия. 
Левой кнопкой мыши выберите “File”→”Open Label”. Откроется окно для выбора файла 
этикетки, выберите для примера этикетку с именем “Universal 56x30.dlb” и нажмите кнопку 
“Open”. 
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Левой кнопкой мыши выберите “File”→“Store Current Label”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Введите имя этикетки для сохранения в принтере как “Middle” и нажните кнопку “Store”. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Левой кнопкой мыши выберите “Print” → “Test Print”. В открывшемся окне выберите 
количество копий и нажмите кнопку “Print”. 
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Принтер отпечатает указанную этикетку. 
 
 
 
 
 
 
 
 
 
4.2 Аналогичным образом загрузите в программу этикетку с именем “Universal 56x30-2.dlb” 
и сохраните ее в принтере под именем “Middle2”, а затем напечатайте ее. 
 
 
 
 
 
 
 
 
 
5.0  Создание этикетки 
 
5.1 Установка параметров этикетки 
 
Левой кнопкой мыши выберите “File” → “Label Setup”.  
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Установите параметры этикетки (размер этикетки 58х40 мм) как на рисунке. Следует иметь 

ввиду, что ширина печати у принтера равна 48 мм, при этом с правого и левого края будут белые 
поля шириной 5 мм. Если размер этикетки по горизонтали будет больше, принтер все равно не 
будет эти места пропечатывать.  Параметры “Width” (ширина) и “Length” (длина по вертикали, 
высота) указаны в пикселях. Ширина одного пикселя равна 1/8 мм. В поле “Language” должен быть 
выбран параметр “Win Cyrillic 1251”, в противном случае печать букв русского алфавита будет 
недоступна. 

  
5.2  Формирование этикетки. 
 
Этикетка создается методом накидывания на поле этикетки различных объектов. Объекты 
делятся на два класса – статический объект (как правило, это обычный текст который 
присутствует на всех этикетках, например название или адрес магазина)  и динамический 
объект (это вес товара, его стоимость, дата упаковки и прочее). Также на этикетке можно 
размещать графические примитивы в виде линий и прямоугольников различной ширины.  На 
этикетке можно разметить логотип предприятия в виде графического монохромного (без 
полутонов) изображения в формате Windows Bitmap (bmp). 
 
5.2.1 Статические объекты. 
 

К статическим объектам  относятся 
• Текст 
• Статический штрих-код для штучного товара 
• Графические примитивы 
• Графический рисунок 

 
Загрузите в программу этикетку 56x40 – 0.dlb как указано в пункте 4.1.  Правой кнопкой 

мыши выберете строку с надписью «МИДЛ ТЕСТ» . Откроется окно в котором можно будет 
сменить: текст, шрифт, размер шрифта по горизонтали и вертикали, стиль, горизонтальное или 
вертикальное отображение текста на этикетке. 
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Для расположения на этикетке нового текстового поля выберите “Draw” → “Text”. 
 
 
 
 
 
 
 
 
Мышкой укажите расположение нового текстового поля, например под логотипом, и 

подтвердите его, нажав на левую кнопку мыши. В раскрывшемся окне введите нужный текст, 
например число «999» и нажмите кнопку «Ok». 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Правой кнопкой мыши выберите изображение статического штрих-кода. В открывшемся 

окне можно менять как значение  штрих-кода, а также его тип, ширину, высоту и прочее. 
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Для расположения нового штрих-кода выберете  “Draw” → “Barcode”. Левой кнопкой мыши 
укажите место расположения штрих-кода и затем в появившемся окне параметров укажите 
нужные данные штрих-кода.  При этом нужно помнить о том, что штрих-код в формате 
EAN-13, это 12-ти разрядное число. Введите 12-ти разрядное число, при этом последний 13-й 
знак будет сформирован автоматически.  Левой кнопкой мыши выберите “Print” → “Test 
Print”. В открывшемся окне выберите количество копий и нажмите кнопку “Print”.  
Убедитесь в том, что напечатанная этикетка соответствует этикетке  на экране дисплея. 
 
Создание и расположение графических примитивов сложности не представляет и в данном 

документе не рассматривается. 
 
Для размещения на этикетке графического рисунка или логотипа необходимо сделать 

следующие действия.  Выберете  “Tools” → “Color to Black&White Converter” . 
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Левой кнопкой мыши нажмите на кнопку “Load”  и в открывшемся окне выберите файл 
Scale.jpg. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
В левой части экрана Вы увидите исходное изображение, а в правой - конвертированное 

черно-белое.  Используя ползунки Brightness(Яркость), Contrast(Контрастность),  Red(Красный), 
Green(Зеленый) и  Blue(Синий) добейтесь наилучшего изображения черно-белого изображения. 
Затем укажите размер изображения по горизонтали в пикселях (width=200), и нажмите кнопку 
“Convert”.   Левой клавишей мыши нажмите на кнопку “Test”.  Принтер отпечатает на этикетке 
отредактированное Вами изображение. Если все устраивает, нажмите кнопку “Save” и сохраните 
полученное изображение в виде файла, например “Scale-BW.bmp”. 



 

 

ООО МИДЛ СЕРВИС                                     (495) 988-52-88 
 

Удалите с этикетки штрих-код для размещения рисунка. Для этого левой клавишей мыши 
выберите на этикетке штрих-код (будет выделен рамкой красного цвета) и нажмите клавишу 
“Delete” на клавиатуре компьютера. 

Для размещения отредактированного изображения на этикетке выберете “Draw” → “Picture”. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Левой клавишей мыши укажите расположение верхнего левого угла картинки, при этом на 

экране появится окно с приглашением ввода имени графического файла. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Левой кнопкой мыши выберете кнопку “From Disk” и в открывшемся окне выберете 

сохраненный графический файл.   
 
 
 
Левой кнопкой мыши выберите “File”→“Store Current Label”.  Введите имя этикетки для 
сохранения в принтере как “Middle” и нажните кнопку “Store”. Левой кнопкой мыши 
выберите “Print” → “Test Print”. В открывшемся окне выберите количество копий и нажмите 
кнопку “Print”. 
 Принтер отпечатает указанную этикетку. 
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5.2.2  Динамические объекты 
 
К динамическим объектам относятся 
 

• Вес 
• Цена за килограмм 
• Стоимость 
• Динамический штрих-код для весового товара 
• Текущие дата и время 

 
Важно.  Для изменения динамических параметров используются следующие переменные 
 

• V0 – вес товара 
• V1 – цена за 1 кг. 
• V2 – стоимость взвешенного товара 
• V3 – вес товара для печати  штрих-кода 
• V4 – цена за 1 кг.  для печати  штрих-кода 
• V5 – стоимость взвешенного товара для печати  штрих-кода 
• TD – текущая дата 
• TT – текущее время 

 
Загрузите в программу этикетку 56x40 – 0.dlb как указано в пункте 4.1.   
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Правой кнопкой мыши выберете строку с надписью «1.034 кг» (выделено в красной рамке). 

Откроется окно, в котором можно будет сменить: текст, шрифт, размер шрифта по горизонтали и 
вертикали, стиль, горизонтальное или вертикальное отображение текста на этикетке. 

Следует обратить особое внимание на запись в поле “Text data”.  Запись V0“ кг” означает, 
что в этом месте принтеру нужно отпечатать значение веса (переменная V0) и через один пробел 
буквосочетание кг.   

 
 
Правой кнопкой мыши выберете строку с надписью «0.00 руб/кг» (выделено в красной 

рамке). 
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Обратите внимание на запись цены за килограмм. Запись V1“ руб/кг” означает, что в этом 

месте принтеру нужно отпечатать значение цены (переменная V1) и через один пробел 
буквосочетание руб/кг. Правой кнопкой мыши выберете строку с надписью «0.00 руб» (выделено в 
красной рамке). 

 
 
 
 
 
 
 
 
 
 
 
 
 

Запись V2“ руб” означает, что в этом месте принтеру нужно отпечатать значение стоимости 
(переменная V2) и через один пробел буквосочетание руб. 

 
ВАЖНО !!!! 
 
У переменных есть такой параметр как их длина. Для корректной печати необходимо чтобы 

указанная длина переменной была больше, чем ее реальная длина. Например, если печатается 
этикетка с весом 17.234 кг. (длина переменной 17.234 равна 5-ти  знакам), то в свойствах этой 
переменной необходимо указать длину большую чем 5 символов. Для этого левой кнопкой мыши 
выберите “Print” → “Define Variables”  
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В поле «Length» должна стоять цифра большая, чем 5 (для веса 17.234 кг), например 7. Это 

правило также относится к длине переменных V1 (цена за кг.) и  V2 (стоимость покупки). Иначе 
говоря, если стоит длина 7 разрядов, то вес, цена за килограмм и стоимость не должны превышать 
9999,999 для веса, 9999,99 для цены и 9999,99 для стоимости. Установите нужную длину для 
переменных V0,V1 и V2 и нажмите кнопку «ОК».  В тестовых образах этикеток длины этих 
переменных равны 7. 

 
Правой кнопкой мыши выберете строку с надписью «08-11-2012» (выделено в красной 

рамке). 

 
Переменная TD в поле Text data говорит о том, что в этом месте на этикетке будет впечатана 

текущая дата, полученная из встроенных в принтер энергонезависимых часов реального времени. 
 
Правой кнопкой мыши выберете строку с надписью «12:20:27» (выделено в красной рамке). 
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Переменная TT в поле Text data говорит о том, что в этом месте на этикетке будет впечатано 

текущее время, полученное из встроенных в принтер энергонезависимых часов реального времени. 
 
Правой кнопкой мыши выберете поле со штрих-кодом (выделено в красной рамке). 
 

В поле Barcode data будет печататься статический штрих-код 2801234567899. Такой код 
имеет смысл только для штучного товара. 

 
Загрузите в программу этикетку 56x40 – 1.dlb как указано в пункте 4.1.  Правой кнопкой 

мыши выберете поле со штрих-кодом (выделено в красной рамке). 
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В поле Barcode data запись “28”V4R5V3R5 означает 
 
28 – префикс весового штрих-кода, может быть в диапазоне от 21 до 29 
V4R5 – печать 5-ти десятичных знаков цены за 1 кг. с отсчетом от последнего знака 
V3R5 – печать 5-ти десятичных знаков веса товара  с отсчетом от последнего знака 
 
Важно.  Для формирования штрих-кода используются только переменные V3, V4 и V5. 
 
ВАЖНО !!!! 
 
У переменных есть такой параметр как их длина. Для корректной печати необходимо чтобы 

указанная длина переменной была больше, чем ее реальная длина. Например, если печатается 
этикетка с весом 17.234 кг. (длина переменной 17.234 равна 5-ти  знакам), то в свойствах этой 
переменной V3 для корректной печати штри-кода необходимо указать длину большую чем 5 
символов. Для этого левой кнопкой мыши выберите “Print” → “Define Variables”  

 
 
 
 
  
 
 
 
 
 
 
 
Это правило также относится к длине переменных V4 (цена за кг.) и  V5 (стоимость 

покупки). Иначе говоря, если стоит длина 5 разрядов (для штри-кода), то вес, цена за килограмм и 
стоимость не должны превышать 99999 для веса, 99999 для цены и 99999 для стоимости. 
Установите нужную длину для переменных V3,V4 и V5 и нажмите кнопку «ОК».  В тестовых 
образах этикеток длины этих переменных V3,V4 и V5 равны 6. 
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5.3 Печать срока реализации товара 
 
Загрузите в программу этикетку 56x40 – 11.dlb как указано в пункте 4.1.  Правой кнопкой 

мыши выберете поле с датой реализации (выделено в красной рамке). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Срок реализации записан как сумма текущей даты и переменной V6.  То есть 12 ноября + 15 

дней = 27 ноября.   
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5.4 Создание этикетки для весов простого взвешивания. 
 
Этикетка создается вышеописанным способом, за исключением того, что на поле этикетки 

отсутствуют поля динамических переменных V1 (цена за килограмм) и V2 (стоимость взвешенного 
товара).  Загрузите в программу этикетку 56x40 – 20.dlb как указано в пункте 4.1.  

 
 

 
Правой кнопкой мыши выберете поле со штрих-кодом (выделено в красной рамке). 
Обратите внимание, что в поле Barcode data присутствует только одна переменная веса (V3) 

и отсутствует переменная цены за килограмм и вместо нее добавлены пять нулей. 
 

 
 
 
 
 
 
 
 
 
Сохраните этикетку в принтере как это описано в пункте 4.2 под именем Middle2. 
 
   
5.5 Создание этикетки для штучного (счетного) режима взвешивания при подключении к 

торговым весам. 
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Важно.  Для изменения динамических параметров этикетки используются следующие 

переменные 
 

• V0 – вес товара 
• V1 – вес 1 шт. взвешенного товара в граммах. 
• V2 – количество взвешенного товара в шт. 
• V3 – вес товара для печати  штрих-кода 
• V4 – вес 1 шт. взвешенного товара в граммах для печати  штрих-кода 
• V5 – количество взвешенного товара в шт. для печати  штрих-кода 
• TD – текущая дата 
• TT – текущее время 

 
Загрузите в программу этикетку «56x40-count_mode_price_scale.DLB»  как указано в пункте 

4.1.   

 
Правой кнопкой мыши выберете строку с надписью «0.00 шт.» (выделено в красной рамке). 
Запись V2“ шт.” означает, что в этом месте принтеру нужно отпечатать количество товара в 

штуках (переменная V2) и через один пробел буквосочетание «шт.». 
Сохраните этикетку в принтере как это описано в пункте 4.2 под именем Mdlcnt. 
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5.6 Создание этикетки для штучного (счетного) режима взвешивания при подключении к 

весам простого взвешивания. 
 
Важно.  Для изменения динамических параметров этикетки используются следующие 

переменные 
 

• V0 – количество взвешенного товара в шт. 
• V3 – количество взвешенного товара в шт. для печати  штрих-кода 
• TD – текущая дата 
• TT – текущее время 

 
Загрузите в программу этикетку «56x40-count mode_simple_scale.DLB»  как указано в пункте 

4.1.   
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Правой кнопкой мыши выберете строку с надписью «0.00 шт.» (выделено в красной рамке). 
Запись V0“ шт.” означает, что в этом месте принтеру нужно отпечатать количество товара в 

штуках (переменная V0) и через один пробел буквосочетание «шт.». 
Сохраните этикетку в принтере как это описано в пункте 4.2 под именем Mdlcnt2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.0  Настройки весовых индикаторов 
 
6.1 Настройка весового индикатора МИ ВД(Ж)А/А-15(Е) Я (торговый индикатор). 
 

Подключите весовой индикатор к сети 220 вольт и включите его, нажав на желтую клавишу 
«ВКЛ». После прохождения теста убедитесь, что во всех разрядах индикатора выведены нулевые 
показания.  Войдите в установки весового индикатора, нажав одновременно клавиши «Ввод» и 
«Итг».  Нажимая кнопку  «Ввод» несколько раз дойдите до отображения на дисплее сообщения 
«con». Введите с помощью цифровой клавиатуры число 14 и нажмите кнопку «Ввод». Нажмите 
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кнопку  «Ввод» еще раз до переключения индикатора в режим отображения  массы, цены и 
стоимости. 

6.2 Настройка весового индикатора МИ ВД(Ж)А/А-12(Е) Я (индикатор простого 
взвешивания). 

 
Подключите весовой индикатор к сети 220 вольт и включите его, нажав на кнопку 

включения, расположенную на задней стенке индикатора. После включения весового индикатора и 
прохождения теста необходимо нажать и удерживать кнопку «Ф» расположенную на передней 
панели до появления на дисплее сообщения «Р1     1». Нажав два раза кнопку «П» выбрать параметр 
Р3 и кнопкой «Т» выбрать значение параметра Р3 равное 1.  Таким образом, устанавливается 
скорость обмена по последовательному порту RS232 равная 9600 бод.  Нажав кнопку «П» еще два 
раза необходимо выбрать параметр Р5 и кнопкой «Т» присвоить ему значение равное 4, что 
соответствует командному режиму передачи данных.  

 
 
7.0  Печать этикеток. 
 
7.1 Ручная печать этикеток.  
 
Подключите принтер, к нижнему разъему весового индикатора соблюдая меры 

предосторожности. Для подключения используйте кабель, поставляемый вместе с принтером.  Во 
время подключения принтер и весовой индикатор должны быть отключены от сети электропитания 
220 вольт.  Включите весовой индикатор и принтер. После прохождения теста и отображения на 
индикаторе нулевых показаний, установите на платформу вес и введите на весовом индикаторе 
цену за один килограмм.  Кратковременно нажмите и отпустите кнопку «LF» на принтере. Принтер 
распечатает этикетку.  Если принтер подключен к торговым весам, то будет печататься этикетка, 
сохраненная в принтере под именем «MIDDLE». В случае подключения принтера к весам простого 
взвешивания – печатается этикетка сохраненная как «MIDDLE2».  Если на торговых не установлена 
цена за один килограмм, то сохраненная как «MIDDLE2».   
  При смене товара, если идет печать с наименованием товара, необходимо загрузить в 
принтер этикетку для следующего товара согласно пункту 4.1 инструкции. 
 

 
7.2 Автоматическая печать этикеток. 
 
Для автоматической печати необходимо DIP-переключатель sw7 перевести в положение 

«On». Принтер будет ожидать в течении двух секунд стабильного показания массы товара и затем 
автоматически распечатает этикетку. После печати принтер будет ждать снятия массы с весов (на 
весах должны установиться нулевые показания массы) и только после установки новой массы 
принтер распечатает этикетку.   

 
 
 
Важно !!! 
 
При создании этикетки и программировании принтера, когда принтер подключен к 

персональному компьютеру, DIP-переключатель sw7 должен находиться в положении OFF.  
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